
Remote Interface Control Center (RICC)

User Handbook

Synopsis Describes how to install and run the RICC program.

Version Program Version 1.1

Date 13.03.2014 Rev 102



    

2

Imprint

Notices

Copyright ©2014, skytron® energy GmbH

This document is protected by copyright. No parts of it may be copied or translated into other languages
without the express, prior written consent of skytron® energy GmbH. The utmost care and attention
have gone into the preparation of this manual, but skytron® energy GmbH accepts no liability for any
errors that may be contained in this document or may result from using it.

The registered trademarks used in this manual are the property of their respective owners.

The following products are registered trademarks of skytron® energy GmbH:

skytron®

ArrayGuard®

PowerGuard®

PVGuard®

RadGuard®

skylog®

skyserv®

StringGuard®

WindGuard®

For any legal issues concerning this document, the place of performance and jurisdiction is Berlin.

Registered Court: Amtsgericht Berlin-Charlottenburg HRB 119505 B

Publisher

skytron energy GmbH Ernst-Augustin-Straße 12 / D - 12489 Berlin
Tel: +49 30 688 31 59 - 0 / Telefax: +49 30 688 31 59 - 99
info@skytron-energy.com / www.skytron-energy.com
Chief executive: Michael Julian



  Contents  

Contents

1 Introduction to the RICC.................................................................................5

2 Installation..................................................................................................... 6
2.1 Before you start..........................................................................................................................6
2.2 System Requirements.................................................................................................................6
2.3 Installing the program................................................................................................................ 6
2.4 Running the program................................................................................................................. 7

3 Using the Program..........................................................................................8
3.1 The Main Program Window....................................................................................................... 8
3.2 Window Operations....................................................................................................................9
3.3 The Program Menu.................................................................................................................. 10

4 The Plant Control Tabs................................................................................. 11
4.1 Overview Tab............................................................................................................................12
4.2 Power Tab.................................................................................................................................13

4.2.1 Active Power Fields.................................................................................................... 15
4.2.2 Reactive Power Fields.................................................................................................16
4.2.3 Apparent Power Fields............................................................................................... 17

4.3 Phase Angle Tab....................................................................................................................... 18
4.3.1 Phase Angle Fields......................................................................................................19

4.4 Active Power Ramp Tab........................................................................................................... 20
4.4.1 Power Ramp Fields..................................................................................................... 21

4.5 Characteristic Curves Tab......................................................................................................... 22
4.5.1 Characteristic Curve Fields......................................................................................... 23

4.6 All Data Tab.............................................................................................................................. 24
4.6.1 Application Information..............................................................................................25
4.6.2 Plant Status.................................................................................................................26
4.6.3 Plant Errors................................................................................................................. 28
4.6.4 Transmission System Operator (TSO) Settings............................................................29
4.6.5 Control Settings.......................................................................................................... 30
4.6.6 Control Parameters.....................................................................................................31
4.6.7 Plant Parameter Fields................................................................................................32
4.6.8 Actual Output Fields...................................................................................................33
4.6.9 Available Characteristics............................................................................................. 34

5 The Event Log...............................................................................................35
5.1 The Controls on the Event Log.................................................................................................35
5.2 Fields of the Event Log.............................................................................................................35

6 Defining a Setpoint.......................................................................................37



  Contents  

6.1 Defining an active power setpoint...........................................................................................37
6.2 Defining a ramp setpoint for the active power........................................................................38
6.3 Defining a reactive power setpoint..........................................................................................38
6.4 Defining a reactive power setpoint based on phase angle...................................................... 38
6.5 Defining a reactive power setpoint based on a curve............................................................. 39

7 Changing the Program Settings.....................................................................40
7.1 Creating a new connection...................................................................................................... 40
7.2 Program Language....................................................................................................................41
7.3 Proxy Settings........................................................................................................................... 41
7.4 Miscellaneous Settings............................................................................................................. 42

8 Actions......................................................................................................... 44
8.1 Chart Context Menus............................................................................................................... 44

8.1.1 Zooming in Chart Context Menus.............................................................................. 44
8.2 Easy Zooming within Charts..................................................................................................... 44

9 Program Updates..........................................................................................46
9.1 Automatic Updates to the Program......................................................................................... 46
9.2 Manually Updating the Program..............................................................................................46



  Introduction to the RICC  

5

1 Introduction to the RICC

The Remote Interface Control Center (RICC) provides operators with a comfortable supervisory interface
through which they can easily control the output of their plant portfolio in real time and apply output
capping.

It connects to one or more skycontrol power plant regulation systems either using an on-site, secure
LAN, or using a virtual-private-network (VPN) internet connection. The system requires the Remote
Interface communication extension (skycontrolRI) to be fitted to the existing skycontrol system.

The RICC allows an operator to configure setpoint parameters for the plants being supervised. The
setpoints can be based on any one of several control mechanisms, such as:

• Active power
• Reactive power
• Phase angle
• The use of pre-defined curves

In addition, an Active Power Ramp setting ensures smooth adjustment of the plant output to changes in
the active power setpoint.

RICC is a Java™-based program and may be installed on Windows, OSX or Linux platforms. Up to 10
individual RICC programs may connect to a single skycontrol system, allowing the plants' current
operational state to visible to all stakeholders; the functionality available may be password protected, so
that users can only perform the actions permitted.

This document describes the operation of the RICC program in detail.
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2 Installation

2.1 Before you start

Before installing RICC you need to:

• Check your computer's configuration
• Ensure you have the correct software environment installed.

These requirements are described in the following sections.

2.2 System Requirements

Operating system

RICC runs on Microsoft Windows™, Apple OS X™ and Linux.

Java™ must be installed on the PC. The most recent version of Java (1.7) is required; the least
update should be installed, and the Java version should be kept up to date.

Processor

At least a dual-core processor

Memory

RAM: Minimum 2 GB

Disk: Minimum 200 MB of free disk space

Video

Recommended resolution: 1920x1080 pixels

2.3 Installing the program

Obtaining the Program

The program can be obtained by downloading it from the RICC program download area. Different
versions are available for different language versions and operating systems.

Run the installation program

Double click on the downloaded installation file (you may need administrator rights to your
computer for the installation to run).

A simple wizard will run (in English). Follow the instructions on the wizard. As part of the
installation you will be required to accept the license terms (these may include terms for standard
open-source components used as part of the program). Tick the Acceptance check box and click on
Next >.

Note:  The language of the program can be changed later from within the program itself.

http://download.pv-guard.com/ricc
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Deinstallation

To remove the program, open the Programs folder in the Windows control panel. Select the
Program Deinstallation option. A list of all installed programs will be displayed; right click on the
Remote Interface Control Center entry, and select Deinstall from the context menu.

A wizard will start to guide you through the deinstallation. Note that as part of this process you will
be asked whether you wish to remove the local RICC Settings. The default is for these to remain.
If you tick the option to remove the settings, this will remove all connection information and their
associated passwords from your PC; you will have to re-enter this information if you choose to re-
install the RICC on your computer again.

2.4 Running the program

Running the program for the first time

When you start the program for the first time you will have to set up a first connection. You will
need the IP Address and Port Number of the skycontrol system concerned. You should get this
information from the technical service engineer who configured the internet link to the plant.

Details about setting up a connection are given in Creating a new connection on page 40.

Once the connection information has been entered and a connection established, the main
program user interface will appear. See The Main Program Window on page 8

Note:  If the RICC is not on the same Local Area Network as the control system, a pre-
configured VPN connection will be required. You should consult the technical service
engineers who configured the network or your local IT network administrator.

Program updates

Updates to the program will be published by skytron from time to time. If the program is connected
to the Internet, these will be detected automatically by the program when it starts, and you will be
prompted to upgrade it. See Automatic Updates to the Program on page 46.

If you leave the program running for a period of time, so that the automatic detection does not
run, then you can use the menu function Tools > Check for Updates to explicitly run the update
detection.

If you do not have a connection to the Internet, skytron will provide updates on CD. Instructions for
installing updates are given in Manually Updating the Program on page 46.
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3 Using the Program

3.1 The Main Program Window

After you start the program and have configured at least one connection, the main program window will
open, as shown below.

Fig 1: The RICC main window

The program display is divided into the following areas:

Area Description

Menu The menu functions are detailed in The Program Menu on page 10.

Active Connections Window This is the main working area of the program. There is an open tab in
this area for every connection you have opened. Each of these contains
several sub-tabs. The tabs are described in The Plant Control Tabs on
page 11.

Connections Window This opens to the left of the Active Connections Window, which lists
all the known connections and allows you to open a connection to
any of them. Double clicking any of the entries will open it - see Active
Connections Window.

Event Log The Event Log is not opened on start-up, but can be opened by the
menu option Window > Event Log.

Status Area There is a status area at the bottom of the program display. This
shows, for example, any minimised windows, and may display
messages and icons in the event of a communications failure or an
update.

Defining Setpoints

For a step-by step guide to defining setpoints in the RICC, see: Defining a Setpoint on page 37
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3.2 Window Operations

The main program window has an extensive range of possibilities for adjusting the size and placement
of the individual window components. The default window arrangement provides you with a working
framework. However, if you wish to optimise the arrangement to better meet the needs of your
situation, you may wish to experiment with some of the options described here.

Note:  The default window arrangement may always be restored using the function: Window >
Reset Windows

Resizing window sections

The borders between the individual sections of the windows may be resized by moving the cursor
over the border, clicking an then dragging it. If this is available, the mouse cursor will change to the
border-resizing mode, shown below.

Fig 2: Resizing borders

Maximising and minimising sub-windows

The sub-windows all have controls at the top right corner that allow you to maximise, minimise or
restore that sub-window.

Using context menus

If you right-click over the tab headers at the top of the sub-windows, a context menu will appear.
The options available will depend on the current arrangement of the sub-windows and tabs.

From the main menu

The Window > Configure Window function allows you to adjust the sub-window that is currently
selected.

Menu functions

The menu functions, either in the main menu or in a sub-window context menu may include the
following entries:

Close Close that sub-window.

Maximize The sub-window will expand to take all of the display.

Float Open that sub-window as a completely separate operating-system
window. For example, you could float the sub-windows for every
plant being controlled by your computer in separate windows,
possibly on separate monitors.

Dock This returns a floating window back to the main program window.

Shift Changes the order of the tabs within a sub-window.
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New Tab Group The Active Connections Window contains a separate sub-tab for
each open connection. This function splits these into individual
sub-windows.

Note:  Closing any sub-window containing an active connection will cause that connection to be
closed.

3.3 The Program Menu

The program menu has the following entries:

File

New Remote Interface
Connection

Create a connection to a new plant

Exit Exits the program. You will be prompted to close each active
connection.

Tools

Install Updates from File Allows you to update the program from a file or CD.

Check for Updates Runs the process to update the program if updates are available.

Plugins Opens a dialog that allows you to update the program.

Options Opens a dialog for changing the program settings and look and
feel.

Window

Connections Opens the Connections Window if it has been closed.

Event Log Opens the Event Log in a sub-window

Configure Window Allows you to change the size and placement of the sub-windows.

Reset Windows Returns the windows their default arrangement.

Close Window Closes the selected window and the associated connection.

Help

About Provides information about the program version.
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4 The Plant Control Tabs

For each connection you open in the RICC, a separate window will open in the Active Connections
Window. Each of these windows will contain a number of tabs, depending on the control application
you are connected to. These may include:

Overview Provides an overall summary of system output, together with status
and any error messages.

Power Displays and allows control of the active and reactive power
components.

Phase Angle Displays and allows control of the reactive power components by
means of the phase angle.

Active Power Ramp Controls how quickly the output power may change following an
adjustment to the output setpoint.

Characteristic Curves Allows you to choose one of a number of characteristic curves that
define how the reactive power should be controlled.

All Data Gives a detailed list of all controls and settings.

The individual tabs are detailed in the next sections.

Note:  The actual tabs that appear, and the exact fields that appear on these tabs, depend on the
configuration of the plant being controlled. For example, some inverters do not allow control of
the reactive power component using Cos φ. A compatibility list is provided at:  skytron Inverter
Compatibility List.

http://www.skytron-energy.com/fileadmin/content/Produkt-PDFs/supported_inverters.pdf
http://www.skytron-energy.com/fileadmin/content/Produkt-PDFs/supported_inverters.pdf
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4.1 Overview Tab

The Overview tab lists key messages from the system. It is divided into three separate panes: a
Plant Summary pane at the top, and separate Status Message and Error Message panes at the
bottom.

Fig 3: The Overview tab

Plant Summary

At the top of the Plant Summary come two entries: Application Id, the name of the running
program running. (Remote Interface Control Center; and the Profile Version, which defines the data
and features provided by the skycontrol Remote Interface.

In the next section, the Active Power, Reactive Power and Apparent Power components of the
corresponding plant's actual output are displayed, with percentile figures to show how close the
plant is running to its rated output.

Next, key details are given concerning the reactive power components of the output: Cos φ, the
Power Factor and the Phase Angle φ.

Finally, the mechanisms currently in use for active and reactive power control are shown.

Status Messages

The Status Messages pane shows a list of messages concerning the current status of the program
and plant controller. A full list of the possible items and their current status are listed in the Plant
Status section of the All Data tab. See Plant Status on page 26.

Error Messages

The Error Messages pane lists any relevant errors that have been logged by the plant or the RICC
program. A full list of the possible errors and their current status are listed in the Plant Errors
section of the All Data tab. See Plant Errors on page 28
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4.2 Power Tab

The Power tab provides you with an at-a-glance picture of the power output at the plants being
monitored.

Fig 4: The Power tab

Power Data

The table at the top of the tab displays output values and set points for the active and reactive
power components and for the resulting apparent power. The individual fields are listed in the
following sections:

1. Active Power Fields on page 15
2. Reactive Power Fields on page 16
3. Apparent Power Fields on page 17

The controls marked by a pencil allow you to adjust the corresponding setpoints:

• The active power
• The reactive power

Either can be set as an absolute value or as a percentage relative to the plant's nominal output.

Note:  For the relative, percentage setting to take effect, the corresponding Enable control
must be explicitly set on.

In addition, you can set whether these values are only in operation whilst the RICC program is
running, or whether you wish the values to be retained one the program has been closed.

Chart: Power Components

The Power Components chart gives a pictorial representation of the active and reactive
components of the output at the current time. An overlay panel shows the actual data. The axes of
the chart will adjust to suit the direction and magnitude of the output.
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Note:  Note that the reactive power axis may 'flip' from time to time.

If you move the mouse across the chart, an overlay panel will show the actual output figures at that
time.

Chart: Power History

The Power History allows you to see the trend of the plant's output (both active and reactive) over
approximately the last hour.

Actions in Charts

A context menu is available if you right-click the mouse over the chart. This is described in Chart
Context Menus on page 44 In addition, you can easily zoom in or out of the chart using the
mouse as described in Easy Zooming within Charts on page 44.

Defining Setpoints

For a step-by step guide to defining the output power setpoints, see:

• Defining an active power setpoint on page 37
• Defining a reactive power setpoint on page 38

Defining Setpoints

For a step-by step guide to defining the output power setpoints, see:

• Defining an active power setpoint on page 37
• Defining a reactive power setpoint on page 38
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4.2.1 Active Power Fields

Field Description Note

Active Power [kW] The instantaneous active component of the output
power.

Active Power [%] The instantaneous active power component as a
percentage of the plant's nominal active power.

Active Power Setpoint [kW] The absolute active power limit that has been set in
the RICC.

1

Active Power Setpoint [%] A percentage-based active power limit that has been
set in the RICC.

1, 2

Active Power Setpoint, PID Controller [kW] The active power setpoint value that the controller is
currently using.

Active Power Setpoint, PID Controller [%] The active power setpoint percentage that the
controller is currently using.

Active Power Limit TSO [kW] The active power limit being enforced by the
transmission system operator.

Active Power Limit TSO [%] The active power limit being enforced by the
transmission system operator as a percentage of the
plant's nominal active power.

Plant Active Power Limit The actual limit being enforced at the current time,
if any. This depends on the actual output of the
plant and the different setpoint settings that have
been configured, either through the RICC or by the
transmission system operator.

Plant Nominal Active Power The plant's nominal (or rated) active power output
capability.

Keep Active Power Setpoint after closing Controls whether the RICC's active power setpoint
should still be applied after the RICC program has
been closed.

1

Relative Active Power Setpoint This control switches the setpoint being used from
the actual value in kW to the relative value in %.
Otherwise the relative value setpoint is ignored.

1, 2, 2

Notes:

1. Click the heading or pencil to change the setting
2. The Active Power Setpoint [%] setting will be ignored unless the Relative Active Power Setpoint

control has been enabled. In this case it overrides any entry in the Active Power Setpoint [kW]
field.

3. Note that, for example, updating the RICC program will cause the connection to be closed, and
the corresponding plant setting will therefore revert to that active in the controller.
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4.2.2 Reactive Power Fields

Field Description Note

Reactive Power [kvar] The instantaneous reactive component of the output
power.

Reactive Power [%] The instantaneous reactive power component as a
percentage of the plant's nominal reactive power

Reactive Power Setpoint [kvar] The absolute reactive power limit that has been set in
the RICC.

1

Reactive Power Setpoint [%] A percentage-based reactive power limit that has
been set in the RICC.

1, 2

Reactive Power Setpoint, PID Controller [kvar] The reactive power setpoint value that the controller
is currently using.

Reactive Power Setpoint, PID Controller [%] The active power setpoint percentage that the
controller is currently using.

Plant Nominal Reactive Power The plant's nominal (or rated) reactive power output
capability.

Keep Reactive Power Setpoint after closing Controls whether the RICC's reactive power setpoint
should still be applied after the RICC program has
been closed.

1

Relative Reactive Power Setpoint This control switches the set point for reactive power
being used from the actual value in kW to the relative
value in %. Otherwise the relative value setpoint is
ignored.

1, 2, 3

Notes:

1. Click the heading or pencil to change the setting
2. The Reactive Power Setpoint [%] setting will be ignored unless the Relative Reactive Power

Setpoint control has been enabled. In this case it overrides any entry in the Reactive Power
Setpoint [kvar] field.

3. Note that, for example, updating the RICC program will cause the connection to be closed, and
the corresponding plant setting will therefore revert to that active in the controller.
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4.2.3 Apparent Power Fields

The fields are listed below:

Field Description Note

Apparent Power [kVA] The plant's apparent output power.

Apparent Power [%] The plant's apparent output as a percentage of its
nominal value.

Plant Apparent Power Limit The actual limit of the apparent power being
enforced at the current time, if any. This depends
on the different setpoint settings that have been
configured, either through the RICC or in the control
system or by the transmission system operator.

Plant Nominal Apparent Power The plant's nominal (or rated) apparent power
output capability.
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4.3 Phase Angle Tab

The Phase Angle tab provides you with an at-a-glance picture of the reactive power phase angle at
the plants being controlled.

Fig 5: The Phase Angle tab

The table at the top of the tab displays phase angle values and set points for the plant. The
individual fields are listed in Phase Angle Fields on page 19.

Clicking the control marked with a pencil by a setpoint entry will cause a dialog to pop up in which
you can change the target parameter.

Note:  The Phase Angle Setpoint is ignored unless the lower control Use Phase Angle
Setpoint instead of Reactive Power Setpoint has been enabled.

Phase Shift Chart

The Phase Shift chart gives a pictorial representation of the phase angle of both voltage and current
at the present time. An overlay panel shows the actual values.

Phase Angle History Chart

The Power History allows you to see the trend of the plant's output (both active and reactive) over
approximately the past hour.

Actions in Charts

A context menu is available if you right-click the mouse over the chart. This is described in Chart
Context Menus on page 44 In addition, you can easily zoom in or out of the chart using the
mouse as described in Easy Zooming within Charts on page 44.

Defining Setpoints

For a step-by step guide to defining the phase angle setpoints, see: Defining a reactive power
setpoint based on phase angle on page 38.
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4.3.1 Phase Angle Fields

The fields are:

Field Description Note

Use Phase Angle Setpoint instead of Reactive Power
Setpoint

By default, the reactive power setpoint is taken
from the absolute value of the reactive power. If you
enable this setting, the phase angle will be used as
the setpoint instead.

1

Phase Angle φ [°] The actual value of the phase angle in degrees.

Cos φ The actual value of Cos φ.

Phase Angle φ Setpoint, PID Controller The phase angle setpoint that the controller is
currently using.

Cos φ Setpoint, PID Controller The Cos φ setpoint that the controller is currently
using.

Phase Angle φ Setpoint Allows you to adjust the setpoint for the reactive
power output by means of the phase angle. Clicking
on the pencil will open a dialog where you can enter
the desired setpoint, either in degrees, or as a value
of Cos φ.

1

Keep Phase Angle Setpoint after closing Controls whether the RICC's phase angle setpoint
should still be applied after the program has been
closed.

1, 2

Notes:

1. Click the heading or pencil to change the setting
2. Note that, for example, updating the RICC program will cause the connection to be closed, and

the corresponding plant setting will therefore revert to that active in the controller.
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4.4 Active Power Ramp Tab

The Active Power Ramp tab allows you to define the maximum rate of change of the output power
following a change in the setpoint.

Fig 6: The Active Power Ramp tab

Power Ramp Data

The table at the top of the tab displays details for defining the power ramp setpoint. The controls
marked by a pencil may be set: the interval and delta defining the maximum rate of change, and
whether the ramp setpoint is enabled.

The individual fields are listed in Power Ramp Fields on page 21.

Actual Ramp Configuration

The chart at the bottom of the display gives a pictorial representation of the slope defined by the
configured settings.

Actions in Charts

A context menu is available if you right-click the mouse over the chart. This is described in Chart
Context Menus on page 44 In addition, you can easily zoom in or out of the chart using the
mouse as described in Easy Zooming within Charts on page 44.

Defining Setpoints

For a step-by step guide to defining the power ramp setpoints, see: Defining a ramp setpoint for the
active power on page 38.
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4.4.1 Power Ramp Fields

The fields are:

Field Description Note

Enable Setpoint Ramp This control allows you to make the Ramp setpoint
active.

1

Setpoint Ramp enabled Shows whether the Ramp setpoint is enabled in the
controller. In this case, either the Plant Default values
will be used or, if the Enable Setpoint Ramp control
has been enabled, the value will be set from the
RICC.

Ramp Interval The Ramp Interval and the Ramp Delta are used as
a convenient mechanism for defining the maximum
rate of change in the plant output following a change
in the setpoint. This is to avoid sudden transients in
the grid; the maximum allowable rate will normally
be defined by the grid organisation. The Ramp Delta
sets the maximum allowed change in output over the
period defined by the Ramp Interval value.

1

Plant Default Ramp Interval Similar to Ramp Interval, this is the default maximum
rate of change of output set in the plant controller;
i.e. the value that will be used if not overridden by
the RICC.

Ramp Delta The Ramp Interval and the Ramp Delta are used as
a convenient mechanism for defining the maximum
rate of change in the plant output following a change
in the setpoint. This is to avoid sudden transients in
the grid; the maximum allowable rate will normally
be defined by the grid organisation. The Ramp Delta
sets the maximum allowed change in output over the
period defined by the Ramp Interval value.

1

Plant Default Ramp Delta Similar to Ramp Delta, this is used to define the
plant controller's default maximum rate of change
of output; i.e. the value that will be used if not
overridden by the RICC.

Notes:

1. Click the heading or pencil to change the setting
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4.5 Characteristic Curves Tab

The Characteristic Curves tab allows you to define the maximum rate of change of the output
power following a change in the setpoint.

Fig 7: Characteristic Curves tab

Characteristic Curves Data

The table at the top of the tab displays details about the curves settings. It allows you to enable or
disable this control mechanism, and to select the curve to be used. It also shows a list of the curves
available in the controller for the plant. The controls marked by a pencil may be set: the Reactive
Power Curve defines the one in use, and whether use of a curve-based setpoint is enabled.

The individual fields are listed in Characteristic Curve Fields on page 23.

Actual Reactive Power Curve

The chart at the bottom of the display gives a pictorial representation of curve that has been
selected for control of the reactive power. The lines show the shape of the curve. The red and blue
dots show the setpoint for the plant under it's actual operating conditions; note that ideally they
will overlay one another. The actual operating point is also shown by the intersection point of the x
and Y axis cross-hairs.

Clicking on the pencil by the Reactive Power Curve will open a dialog box where you can change
the curve being used. The shape of the curves are previewed in the dialog. The available curves will
depend on the country and region in which the plant is operating. A selection of some of the curves
available in Germany are illustrated below.

Fig 8: Selection of the available curves (Germany)

Defining Setpoints

For a step-by step guide to defining the curve-based setpoints, see: Defining a reactive power
setpoint based on a curve on page 39.
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4.5.1 Characteristic Curve Fields

The fields are:

Field Description Note

Enable Reactive Power Curve This control allows you to turn on the reactive power
setpoint control based on the selected curve.

1

Reactive Power Curve enabled Shows whether the controller is using the curve-
based control for the reactive power.

Reactive Power Curve This control shows which of the possible curves is
currently selected. Clicking on the pencil will open a
dialog showing the shape of the curve, and allow you
to change it to another curve.

2

Available Reactive Power Curves Shows you a list of all possible curves that have
been configured in your controller (the list will vary
depending on region and country).

Notes:

1. Click the heading or pencil to change the setting
2. Clicking on the pencil will bring up a dialog which shows the form of the selected curve,

together with a pop-down list allowing the curve to be changed. Selecting any of the other
curves will allow the form of that curve to be seen before it is selected.
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4.6 All Data Tab

The All Data tab summarises the current values of all data and settings from the other tabs.

Fig 9: The All Data tab

The display is broken into the following sections:

1. Application Information on page 25
2. Plant Status on page 26
3. Plant Errors on page 28
4. Transmission System Operator (TSO) Settings on page 29
5. Control Settings on page 30
6. Control Parameters on page 31
7. Plant Parameter Fields on page 32
8. Actual Output Fields on page 33
9. Available Characteristics on page 34
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4.6.1 Application Information

The fields are listed below:

Field Description Note

Application Id The name of the corresponding application that
the RICC program is communicating with on the
skycontrol system.

Profile Version Shows which variant of the program is running.
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4.6.2 Plant Status

The fields are listed below:

Field Description Note

General Fault (Warning) Will be set if any of the errors in the Plant Error
section occurs.

Plant Feeds Indicates that the plants are currently feeding the
grid. Is the opposite of the Plant Shutdown error
field.

Plant controllable for RICC Indicates that the plant controller can accept RICC
commands.

Active RICC detected Indicates that the plant controller has identified a
version of the RICC program. (Note however that
more than one RICC program may communicate with
any controller, though this is not recommended.)

Currently limited by Transmission System Operator The output is currently being capped at the level set
by the transmission system operator.

Currently limited by RICC The output is currently being capped at the level set
in the RICC program.

Manual local limit The output is currently being capped at a level set
manually in the plant controller.

Currently limited by Automation/Protection The plant's output is being limited because of an
automatic plant protection mechanism running in the
controller

Interface enabled in skycontrol This status field should always be set.

Interface in Master Mode Where a plant is controlled by a number of
interconnected skycontrol systems, one of them
will act as a Master. This setting shows such an
arrangement is active. Otherwise the RICC program is
only communicating with a single skycontrol system.

Keep Active Power Setpoint after closing Controls whether the RICC's active power setpoint
should still be applied after the RICC program has
been closed.

Keep Reactive Power Setpoint after closing Controls whether the RICC's reactive power setpoint
should still be applied after the RICC program has
been closed.

Keep Phase Angle Setpoint after closing Controls whether the RICC's phase angle setpoint
should still be applied after the program has been
closed.

Setpoint Ramp enabled Shows whether the Ramp setpoint is enabled in the
controller. In this case, either the Plant Default values
will be used or, if the Enable Setpoint Ramp control
has been enabled, the value will be set from the
RICC.

Reactive Power Curve enabled Shows whether the controller is using the curve-
based control for the reactive power.

Remote Interface Activity Signal This setting will toggle between Enabled and Disabled
every few seconds to indicate to the RICC that the
plant control system is functioning.
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Field Description Note

Active Power Setpoint, PID Controller [%] The active power setpoint percentage that the
controller is currently using.

Active Power Setpoint, PID Controller [kW] The active power setpoint value that the controller is
currently using.

Reactive Power Setpoint, PID Controller [%] The active power setpoint percentage that the
controller is currently using.

Reactive Power Setpoint, PID Controller [kvar] The reactive power setpoint value that the controller
is currently using.

Phase Angle φ Setpoint, PID Controller The phase angle setpoint that the controller is
currently using.

Cos φ Setpoint, PID Controller The Cos φ setpoint that the controller is currently
using.

Active Power Controlled by Shows which type of setpoint is being used to control
the active power. Options include: No Selection,
Absolute Setpoint, Relative Setpoint.

Reactive Power Controlled by Shows which type of setpoint is being used to control
the reactive power. Options include: No Selection,
Absolute Setpoint, Relative Setpoint, Phase Angle,
Curve, External Source.
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4.6.3 Plant Errors

The fields are listed below:

Field Description Note

Remote Site Inactive Indicates that the controller has not detected a
toggling RICC Activity Signal.

Invalid Active Power Setpoint Somehow an invalid setpoint value has been set in
the controller. This should not occur and indicates
a serious problem in the controller, RICC or other
control program attached to the controller.

Invalid Reactive Power Setpoint Somehow an invalid setpoint value has been set in
the controller. This should not occur and indicates
a serious problem in the controller, RICC or other
control program attached to the controller.

Invalid Phase Angle Setpoint Somehow an invalid setpoint value has been set in
the controller. This should not occur and indicates
a serious problem in the controller, RICC or other
control program attached to the controller.

Plant shut down The plant feed to the grid has been shut down.

Slave unreachable Indicates that the RICC program was not able to
establish a connection to the slave communication
interface running in the controller.

Invalid Ramp Interval Somehow an invalid setpoint value has been set in
the controller. This should not occur and indicates
a serious problem in the controller, RICC or other
control program attached to the controller.

Invalid Ramp Delta Somehow an invalid setpoint value has been set in
the controller. This should not occur and indicates
a serious problem in the controller, RICC or other
control program attached to the controller.

Reactive Power Curve Configuration invalid Somehow an invalid curve has been configured in
the controller. This should not occur and indicates
a serious problem in the controller, RICC or other
control program attached to the controller.
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4.6.4 Transmission System Operator (TSO) Settings

The fields are listed below:

Field Description Note

Active Power Limit TSO [%] The active power limit being enforced by the
transmission system operator as a percentage of the
plant's nominal active power.

Active Power Limit TSO [kW] The active power limit being enforced by the
transmission system operator.
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4.6.5 Control Settings

The fields are listed below:

Field Description Note

Remote Control enabled Shows whether the controller may be operated by
the RICC. Should always be shown as enabled.

Keep Active Power Setpoint after closing Controls whether the RICC's active power setpoint
should still be applied after the RICC program has
been closed.

4

Keep Reactive Power Setpoint after closing Controls whether the RICC's reactive power setpoint
should still be applied after the RICC program has
been closed.

4

Keep Phase Angle Setpoint after closing Controls whether the RICC's phase angle setpoint
should still be applied after the program has been
closed.

4

Enable Setpoint Ramp This control allows you to make the Ramp setpoint
active.

Activity Signal This setting will toggle between Enabled and Disabled
every few seconds to indicate to the plant control
system that the RICC is functioning.Correct?

Relative Active Power Setpoint This control switches the setpoint being used from
the actual value in kW to the relative value in %.
Otherwise the relative value setpoint is ignored.

1, 2

Relative Reactive Power Setpoint This control switches the set point for reactive power
being used from the actual value in kW to the relative
value in %. Otherwise the relative value setpoint is
ignored.

1, 3

Use Phase Angle Setpoint instead of Reactive Power
Setpoint

By default, the reactive power setpoint is taken
from the absolute value of the reactive power. If you
enable this setting, the phase angle will be used as
the setpoint instead.

Notes:

1. Click the heading or pencil to change the setting
2. The Active Power Setpoint [%] setting will be ignored unless the Relative Active Power Setpoint

control has been enabled. In this case it overrides any entry in the Active Power Setpoint [kW]
field.

3. The Reactive Power Setpoint [%] setting will be ignored unless the Relative Reactive Power
Setpoint control has been enabled. In this case it overrides any entry in the Reactive Power
Setpoint [kvar] field.

4. Note that, for example, updating the RICC program will cause the connection to be closed, and
the corresponding plant setting will therefore revert to that active in the controller.
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4.6.6 Control Parameters

The fields are listed below:

Field Description Note

Active Power Setpoint [%] A percentage-based active power limit that has been
set in the RICC.

1, 2

Active Power Setpoint [kW] The absolute active power limit that has been set in
the RICC.

1

Reactive Power Setpoint [%] A percentage-based reactive power limit that has
been set in the RICC.

1, 3

Reactive Power Setpoint [kvar] The absolute reactive power limit that has been set in
the RICC.

1

Phase Angle φ Setpoint Allows you to adjust the setpoint for the reactive
power output by means of the phase angle. Clicking
on the pencil will open a dialog where you can enter
the desired setpoint, either in degrees, or as a value
of Cos φ.

Ramp Interval The Ramp Interval and the Ramp Delta are used as
a convenient mechanism for defining the maximum
rate of change in the plant output following a change
in the setpoint. This is to avoid sudden transients in
the grid; the maximum allowable rate will normally
be defined by the grid organisation. The Ramp Delta
sets the maximum allowed change in output over the
period defined by the Ramp Interval value.

Ramp Delta The Ramp Interval and the Ramp Delta are used as
a convenient mechanism for defining the maximum
rate of change in the plant output following a change
in the setpoint. This is to avoid sudden transients in
the grid; the maximum allowable rate will normally
be defined by the grid organisation. The Ramp Delta
sets the maximum allowed change in output over the
period defined by the Ramp Interval value.

Reactive Power Curve This control shows which of the possible curves is
currently selected. Clicking on the pencil will open a
dialog showing the shape of the curve, and allow you
to change it to another curve.

4

Notes:

1. Click the heading or pencil to change the setting
2. The Active Power Setpoint [%] setting will be ignored unless the Relative Active Power Setpoint

control has been enabled. In this case it overrides any entry in the Active Power Setpoint [kW]
field.

3. The Reactive Power Setpoint [%] setting will be ignored unless the Relative Reactive Power
Setpoint control has been enabled. In this case it overrides any entry in the Reactive Power
Setpoint [kvar] field.

4. Clicking on the pencil will bring up a dialog which shows the form of the selected curve,
together with a pop-down list allowing the curve to be changed. Selecting any of the other
curves will allow the form of that curve to be seen before it is selected.
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4.6.7 Plant Parameter Fields

The fields are listed below:

Field Description Note

Plant Nominal Apparent Power The plant's nominal (or rated) apparent power
output capability.

Plant Nominal Active Power The plant's nominal (or rated) active power output
capability.

Plant Nominal Reactive Power The plant's nominal (or rated) reactive power output
capability.

Plant Apparent Power Limit The actual limit of the apparent power being
enforced at the current time, if any. This depends
on the different setpoint settings that have been
configured, either through the RICC or in the control
system or by the transmission system operator.

Plant Active Power Limit The actual limit being enforced at the current time,
if any. This depends on the actual output of the
plant and the different setpoint settings that have
been configured, either through the RICC or by the
transmission system operator.

Plant Default Ramp Interval Similar to Ramp Interval, this is the default maximum
rate of change of output set in the plant controller;
i.e. the value that will be used if not overridden by
the RICC.

Plant Default Ramp Delta Similar to Ramp Delta, this is used to define the
plant controller's default maximum rate of change
of output; i.e. the value that will be used if not
overridden by the RICC.
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4.6.8 Actual Output Fields

The fields are listed below:

Field Description Note

Apparent Power [%] The plant's apparent output as a percentage of its
nominal value.

Apparent Power [kVA] The plant's apparent output power.

Active Power [%] The instantaneous active power component as a
percentage of the plant's nominal active power.

Active Power [kW] The instantaneous active component of the output
power.

Reactive Power [%] The instantaneous reactive power component as a
percentage of the plant's nominal reactive power

Reactive Power [kvar] The instantaneous reactive component of the output
power.

Cos φ The actual value of Cos φ.

Phase Angle φ [°] The actual value of the phase angle in degrees.

Power Factor The actual value of the power factor.

Line Voltage (Phase Mean) The mean line voltage across all phases, as measured
by the skycontrol unit.

Line Current (Phase Sum) The sum of all phase currents, as measured by the
skycontrol unit.



  The Plant Control Tabs  

34

4.6.9 Available Characteristics

The fields are listed below:

Field Description Note

Available Reactive Power Curves Shows you a list of all possible curves that have
been configured in your controller (the list will vary
depending on region and country).
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5 The Event Log

You can open the RICC event log by using the menu function Window > Event Log. The event log will
open in a separate at the bottom of the RICC program window. It appears as shown in Fig 10: The RICC
Event Log showing the controls.

Fig 10: The RICC Event Log showing the controls

5.1 The Controls on the Event Log

At the top of the log are a number of controls for using the log. These have the following functions:

Allows you to export the event log. Clicking on this button causes a Save dialog to appear, where
you can select the file into which the data is to be stored. Data is stored in a Comma Separated
Variable (.csv) format, and takes account of the filters you have currently applied to the log.

Clears all entries from the log.

Includes setpoint events in the display.

Includes connection events in the display.

Includes connection errors in the display.

5.2 Fields of the Event Log

The event log includes the following fields.

Note:  Double clicking in the header row at the top of any column will sort the log according to
that column.

Id Each entry has a unique identification number in the log.

Timestamp Provides the data and time of the event of error.

Level Entries are classified into Levels. Can take the values: Message,
Warning, User Action, Error.

Connection Controls how quickly the output power may change following an
adjustment to the output setpoint.

User Name Shows the user of the program when the event occurred.
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Type A categorisation of the event or error type. Can take the values:
Connection Established, Connection Failed, Connection Closed, Value
Set, Transfer Error.

Value Where an event or error involves a particular parameter, this field
gives the name of the parameter.

Data Where an event or error involves a particular parameter, this field
gives the actual data for the parameter.

Details Provides more information about the event or error.
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6 Defining a Setpoint

This section describes the steps to configure one of the various setpoints available for capping a
plant's active or reactive power output.

Active Power

To define a setpoint on the active power output, goto Defining an active power setpoint.

You may also like to set up a power ramp setpoint for the active power output. To do this, see
Defining a ramp setpoint for the active power.

Reactive Power

There are a number of ways to define a setpoint on the reactive power output. You can:

• Configure a setpoint based on the actual output figure in kvar or as a percentage of the plant's
output. Go to Defining a reactive power setpoint.

• By defineing a setpoint based on the reactive power phase angle. Go to Defining a reactive
power setpoint based on phase angle.

• By defining the operation to be based on a prefined curve. Go to Defining a reactive power
setpoint based on a curve.

6.1 Defining an active power setpoint

You need to define a setpoint on the plant's active power output.

1. Open the Power tab.
2. Decide whether you want to enter the setpoint as an absolute figure in kW, or as a percentage

of the plant's rated power.
3. To enter the setpoint as an absolute value:

• Click the pencil by the Active Power Set Point [kW] entry.
• A dialog will appear where you can enter the setpoint value.
• If you have previously defined the setpoint as a percentage, click the pencil by the Relative

Active Power Set Point entry, and confirm that you do not want to use the relative,
percentage figure.

4. To enter the setpoint as a percentage of the plant's rated power:

• Click the pencil by the Active Power Set Point [%] entry.
• A dialog will appear where you can enter the setpoint value.
• Click the pencil by the Relative Active Power Set Point entry. A dialog will appear where you

can confirm you wish to use the relative, percentage figure.
5. If you wish the setpoint to remain active after you have closed the RICC program or during a

restart e.g. when you update the program:

• Click the pencil by the Keep Active Power setpoint after closing entry.
• A dialog will appear to allow you to confirm the retention of the setpoint value.

6. Decide whether you wish to establish a setpoint for the Active Power Ramp. To do this, see
Defining a ramp setpoint for the active power.
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6.2 Defining a ramp setpoint for the active power

You need to define a ramp setpoint to control the speed of change of the plant's active power
output.

1. Open the Power Ramp tab.
2. Click the pencil by the Ramp Interval entry, and set the interval that defines the ramp gradient.
3. Click the pencil by the Ramp Delta entry, and set the maximum change in power (delta) that is

allowed in the power interval.
4. The power change gradient will be shown in the lower graph. Check that this is correct.
5. Click the pencil by the entry Enable Set Point Ramp. A dialog will appear for you to confirm this.

6.3 Defining a reactive power setpoint

You need to define a setpoint on the plant's reactive power output.

1. Open the Power tab.
2. Decide whether you want to enter the setpoint as an absolute figure in kvar, or as a percentage

of the plant's rated reactive power.
3. To enter the setpoint as an absolute value:

• Click the pencil by the Reactive Power Set Point [kvar] entry.
• A dialog will appear where you can enter the setpoint value.
• If you have previously defined the setpoint as a percentage, click the pencil by the Relative

Active Power Set Point entry, and confirm that you do not want to use the relative,
percentage figure.

4. To enter the setpoint as a percentage of the plant's rated reactive power:

• Click the pencil by the Reactive Power Set Point [%] entry.
• A dialog will appear where you can enter the setpoint value.
• Click the pencil by the Relative Reactive Power Set Point entry. A dialog will appear where

you can confirm you wish to use the relative, percentage figure.
5. If you wish the setpoint to remain active after you have closed the RICC program, click the pencil

by the Keep Reactive Power setpoint after closing entry. A dialog will appear to allow you to
confirm the retention of the setpoint value.

6. If you have previously been using a setpoint based on the phase angle, open the Phase Angle
tab, and click the pencil by the entry Use Phase Angle Setpoint instead of Reactive Power
Setpoint. Disable the phase angle setpoint.

7. If you have previously been using a setpoint based on a curve, open the Characteristic Curves
tab, and click the pencil by the entry Enable Reactive Power Curve. Disable the reactive power
curve operation.

6.4 Defining a reactive power setpoint based on phase angle

You need to define a setpoint on the plant's reactive power output based on the phase angle.

1. Open the Phase Angle tab.
2. Click the pencil by the Phase Angle φ Setpoint entry. A dialog will appear where you can enter

the setpoint value.



  Defining a Setpoint  

39

3. Click the pencil by the entry Use Phase Angle Setpoint instead of Reactive Power Setpoint.
Confirm that you wish to use the phase angle setpoint.

4. If you wish the setpoint to remain active after you have closed the RICC program, click the
pencil by the Keep Phase Angle Setpoint after closing entry. A dialog will appear to allow you to
confirm the retention of the setpoint value.

5. If you have previously been using a setpoint based on an absolute or percentage value, disable
this by opening the Power tab, and clicking the pencil by the entry Relative Active Power Set
Point. Disable the option in the dialog.

6. If you have previously been using a setpoint based on a curve, open the Characteristic Curves
tab, and click the pencil by the entry Enable Reactive Power Curve. Disable the reactive power
curve operation.

6.5 Defining a reactive power setpoint based on a curve

You need to configure the plant to operate according to a grid operator's defined characteristic
curve.

1. Open the Characteristic Curves tab.
2. Click the pencil by the Reactive Power Curve entry. A dialog will appear where you can select

the curve you wish to use. Select the appropriate curve.
3. Click the pencil by the entry Enable Reactive Power Curve. Confirm use of the curve-based

operation.
4. If you have previously been using a setpoint based on an absolute or percentage value, disable

this by opening the Power tab, and clicking the pencil by the entry Relative Active Power Set
Point. Disable the option in the dialog.

5. If you have previously been using a setpoint based on a phase angle, Phase Angle tab, and click
the pencil by the entry Use Phase Angle Setpoint instead of Reactive Power Setpoint. Disable
the phase angle based operation.
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7 Changing the Program Settings

7.1 Creating a new connection

In order to connect a new plant you will need to enter a new connection - the link between the
RICC program and the plant controller being monitored and controlled.

Open the command File > New Remote Interface Connection. The dialog Create Connection will
appear as shown below.

Fig 11: The Edit Connection dialog

In the upper half of the dialog fill in the connection details as follows:

Field Description

Connection Name Any name you choose. Is the name that is shown in the
Connection Window of the main window.

User Name The user name associated with this connection (2-20 characters).
You may choose any name you like, this is used to prevent non-
authorised staff from accessing the program. (The user name is
not associated with any user-id needed at a technical level to
establish communications connections.)

Password The password for this connection (4-20 characters).

Connection URL An IP Address or URL and Port Number for the skycontrol unit
being controlled. In the usual case of an IP address, this will
be in the form <IP-address>:<port-number>. For example
172.16.103.237:1502. The correct values will be notified by
the skytron technicians.
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Field Description

Slave Id This entry, a digit, defines a program interface within the
controller, for example 0 or1. The correct value will be notified to
you by skytron.

Data Refresh Interval Here you can specify how often in seconds you wish the display to
be refreshed for this connection.

Note:  The user name and password entered here are used to control access to the various
controls and settings displayed by the program, to ensure only permitted users may observe
or control a plant's output, and to ensure that those users only allowed to view the output
may be prevented from interfering with the actual plant supervision. The user name and
password are, however, independent of any user-name and password needed for the VPN
or other connection to the plant.

In the lower half of the dialog you can control how the user name and password are to be used.
You can configure the RICC to prompt the user for the user name and password whenever:

• They try to open a connection to a plant
• They wish to edit the connection details described above
• They attempt to change any of the control settings or parameters for the skycontrol unit

7.2 Program Language

The language of the program's user interface may be easily changed as described here.

Open the command Tools > Options. The dialog Options will appear as shown below.

Fig 12: The Options dialog on opening

The program language can be changed in the drop-down box in this form. You will need to restart
the program for the change to take effect.

7.3 Proxy Settings

The RICC program includes features such as automatic update. For this to work, the program must
be able to establish an Internet connection. If the program reports that it cannot connect to the
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Internet, then the most likely reason is that your organisation uses a Proxy Server to connect to the
Internet. In this case, the settings for this must be entered correctly.

Open the command Tools > Options The dialog Options will appear.

Click on the General button. Th form will appear as shown below.

Fig 13: The General tab in the Options dialog

There are three options:

No Proxy Click this box if your organisation uses a direct connection to the
Internet, without any Proxy Server.

Use System Proxy Settings If you tick this box, then any default proxy settings that have been
configured for your computer will be used. Check for example the
Windows Control Panel or your system administrator.

Manual Proxy Settings In this case you must enter the settings yourself in the two fields
HTTP Proxy and Port. The first will typically be an IP Address such
as 192.168.200.100 and the second a number such as 8080.

In the rare case that the Manual Settings are insufficient for the requirements of your
organisation's infrastructure, further options (e.g. settings for an HTTPS proxy) are available by
clicking the More... button.

7.4 Miscellaneous Settings

The Miscellaneous button of the Options dialog allows you to change various parameters concerning
the program's look and feel. Of these, the most useful is the Preferred look and feel option, which
enables you to change the program appearance from, for example, a light background to a darker
display.

Dragging and Snapping (top section)

The settings in this section affect the program's behaviour if you try to drag (for example) one
of the connection windows to another point in the program. The Drag window image setting,
for example, sets whether a thumbnail image will follow the mouse as you move the connection
window.
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Connection Tabs

These settings affect the program's behaviour when you open a second or third connection window
- how the multiple tabs will be placed in relation to each other, and where they will be placed in the
program window.

Look and Feel

These settings allows a choice of around six different appearances for the program, and how closely
they match the appearance of the native operating system (e.g. Windows) on your PC. The images
in the current manual are based on the Nimbus look and feel.

Fig 14: A variety of different options for look and feel
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8 Actions

8.1 Chart Context Menus

Right clicking over one of the charts shows a context menu. This may include the following entries:

Copy Copies the chart to the clipboard as a picture.

Save as... Allows you to save the picture in the Portable Network Graphics
(.png)format.

Print... Allows you to print the chart directly to a printer.

Zoom In See Zooming in Chart Context Menus

Zoom Out See Zooming in Chart Context Menus.

Auto Range See Zooming in Chart Context Menus.

8.1.1 Zooming in Chart Context Menus

The last three menu entries (Zoom In, Zoom Out, Auto Range) include the same sub-menu, as follows:

Both Axes Here both axes are zoomed together.

Domain Axis The Domain Axis is the horizontal (time) axis. This function will enlarge
or contract the view of this axis.

Range Axis The Range Axis is the vertical axis. This function will enlarge or contract
the view of this axis.

Note:  Zooming is also possible using a mouse. See Easy Zooming within Charts on page 44.

8.2 Easy Zooming within Charts

You may wish to zoom in to look at a particular feature in a displayed chart. Normally a context
menu will allow this through a zoom-in or out command, however there are a shortcuts available
with the mouse.

To zoom in to the chart, left click with the mouse at the top right position of the area you wish to
enlarge. Then, holding the mouse button down, drag the mouse to the bottom right corner of the
area. The zoom area will be mark as a selection while you drag. Finally, release the mouse button
and the chart will zoom in to show just the selected area.



  Actions  

45

Fig 15: Zooming in

To zoom back out, left-click with the mouse at any point of the chart display and, holding the
mouse button down, drag the mouse towards the top left of the chart. Release the mouse key, and
the chart will zoom out to its fullest extent.

Fig 16: Zooming out
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9 Program Updates

9.1 Automatic Updates to the Program

If the program has a working Internet connection, it will detect automatically when any updates are
available. You will be alerted by:

• A balloon box appearing for a short time above the status bar at the bottom-right of the
program window.

• The update-required symbol being shown in the status bar. If you click this symbol, the balloon
box will reappear.

Fig 17: The Automatic Update prompt and Update Required icon

Warning:  Depending on the nature of the update, the process may run fully automatically
or a wizard may run to walk you through any necessary changes (see, for example, Manually
Updating the Program on page 46). At the end of the process you will be required to
restart the program and re-open any connections.

9.2 Manually Updating the Program

If the program does not have a working Internet connection, you will have to install any program
updates manually. The updates will be provided by skytron, usually as a file that you can download.

Warning:  During the update process you will be required to restart the program and re-
open any connections.

1. If the updates have been provided as a single download zip file, move or copy the file into a
temporary directory and extract it there.

2. In the program, select Tools > Install Updates from File from the menu.
3. The Select Update Files dialog will appear as shown in the figure below.

Fig 18: The Select Update Files dialog

The update files will be located in the extracted zip file (or file on a CD) in a subdirectory called
update or similar. The have the file extension ".nbm". In the dialog, select the directory
containing these files, and click Open.

4. A wizard called Plugin Installer will may appear. This will walk you through the steps of the
update.
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Fig 19: Page 1 of the Plugin Installer dialog

Click on Next >.
5. At the end of the process you can choose whether you wish to restart the RICC application now

or at a later time, as shown below.

Fig 20: Page 2 of the Plugin Installer wizard

Warning:  If you choose the option Restart Now and there are any connections open to
plants, these connections will be closed. If you have not chosen the option to keep the
setpoints after closing, then the output setpoints of the corresponding plants will revert
to the plant defaults (or none).

6. If you choose to delay restarting the program, the restart-required icon will persist in the status
bar at the bottom-right of the program window. Clicking on this symbol will allow you to restart
the program.

Fig 21: The Restart Required icon
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